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Installation Overview
You can install TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture either 
by using the TIBCO Universal Installer or an update site.

 l Installing by Using the TIBCO Universal Installer 

You can install the plug-in by using the TIBCO Universal Installer, in the following 
modes: GUI, console, and silent. To skip to the procedure, see Installation Modes and 
Procedures.

 l Installing by Using an Update Site 

You can install the plug-in from within TIBCO Business Studio™ for BusinessWorks™ 
by using the public update site maintained by TIBCO, using a local update site 
managed by your organization, or BusinessWorks Plug-ins Manager.

The plug-in must be installed into an existing installation environment where TIBCO 
ActiveMatrix BusinessWorks™ is already installed. The installation environment of 
ActiveMatrix BusinessWorks™ is referenced as TIBCO_HOME.

Note: TIBCO recommends that you use the same mode for uninstallation that 
you used for installing the plug-in. Using different methods for installation and 
uninstallation might cause some problems during uninstallation.
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Installation Requirements
Before you install the plug-in, ensure that your system meets all the hardware and 
software requirements and you have appropriate privileges to run the installer.

Installation Account and Permission 
Requirements
To install on Microsoft Windows, Linux, or macOS, you must have appropriate privileges. 
Privileges differ for various platforms.

Note: Use the same installer account to install all ActiveMatrix BusinessWorks 
products.

Platform       Account Privileges

Microsoft 
Windows        

Only users with administrator privileges can install the plug-in. If you do not 
have administrator privileges, the installer automatically exits.

To install the product on a network drive, ensure that the account used for 
installation has permission to access the network drive.

Linux        Both regular (non-root) user and super-user (root) can install the plug-in.

A graphic environment such as CDE or X Windows is required to run the 
installer in GUI mode.

macOS Both regular (non-root) user and super-user (root) can install the plug-in.

System Requirements
Ensure that your system meets the hardware and software requirements before installing 
the plug-in. 
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Platform
Before you run the installer, ensure that the appropriate platform is supported. For 
information about supported operating system platforms, versions, and the required 
patches, see the Readme file.

Disk Space
The installer requires some space in the local directory before installation, and additional 
space in the local directory to run the installer. Ensure that sufficient space is available in 
the directory that you want to use as the installation environment (TIBCO_HOME).

Note: While installing the product, avoid running other processes that use disk 
space in the installation environment directory. If another process uses disk 
space while the installer is copying files, the installer might fail and display a 
failure message.

Software Requirements
Ensure that you have installed the required software before you run the installer. For 
information about supported products and versions, see the Readme file.

The following table lists required and optional TIBCO products:

Software Description

TIBCO ActiveMatrix 
BusinessWorks™

Required.

ActiveMatrix BusinessWorks supports your integration project 
throughout the project life cycle. It includes a common graphical user 
interface for configuration, process design, and deployment.

TIBCO® Enterprise 
Administrator

Optional.

https://docs.tibco.com/dyno/bwplugincdc/6.2.0/TIB_bwplugincdc_6.2.0_readme.txt
https://docs.tibco.com/dyno/bwplugincdc/6.2.0/TIB_bwplugincdc_6.2.0_readme.txt
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Software Description

TIBCO Enterprise Administrator consists of a TIBCO Enterprise 
Administrator server, a web user interface for the server, and a shell 
interface, with which you can manage the applications that you create in 
TIBCO Business Studio for BusinessWorks. 
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Installing by Using the TIBCO Universal 
Installer
You can install the ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture by using 
the TIBCO Universal Installer, in the following modes: GUI, console, and silent.

Ensure that your system meets all the requirements described in the Installation 
Requirements section.

Note: The plug-in must be installed in the same installation environment where 
ActiveMatrix BusinessWorks is installed. Stop all running processes in the 
installation environment before the installation.    

Using the TIBCO Universal Installer, you can select the installation environment and the 
installation component.

If you are using the TIBCO Universal Installer for the first time to install the plug-in, review 
the following topics before the installation:

 l Installation Environment

 l Installation Components and Profiles

 l Installation Modes and Procedures

Installation Environment
An installation environment isolates product installations. A product installed in one 
installation environment cannot access components in other installation environments.

An installation environment is the top-level installation directory for TIBCO products. An 
installation environment consists of the following properties:
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Property Description

Directory Identifies the directory where the product is installed. 

TIBCO_HOME It is the top-level installation directory for TIBCO products.

Name Identifies the name of the folder where the product is installed.

Installation Components and Profiles
Different installation components are associated with different functions. Using the TIBCO 
Universal Installer, you can select installation components during the installation.

Installation components are grouped into different installation profiles. One installation 
profile is associated with one or more installation components. When you select a profile, 
the components under the selected profile are installed. By default, the Typical installation 
profile is selected. Thus, the Design and Runtime installation components are installed.

The following installation components are available with the plug-in:

Component Description

TIBCO ActiveMatrix 
BusinessWorks™ 
Plug-in for Change 
Data Capture 
Design

This component includes the palettes, shared resources, and samples 
that show how the plug-in interacts with ActiveMatrix BusinessWorks. 
You can configure your own business process in TIBCO Business Studio 
for BusinessWorks with an Eclipse user interface.

Note: To install TIBCO ActiveMatrix BusinessWorks™ Plug-in for 
Change Data Capture Design, a runtime component is required. 

TIBCO ActiveMatrix 
BusinessWorks™ 
Plug-in for Change 
Data Capture 
Runtime

This component passes and converts data to and from vendor 
applications. The parameters of data exchange are stored in projects 
that are created by using the plug-in palette.
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Installation Modes and Procedures
You can run the TIBCO Universal Installer in GUI, console, or silent mode. Each mode is 
supported on all platforms. Ensure that your system meets all the requirements described 
in Installation Requirements.

Note: The plug-in must be installed in an existing installation environment 
where ActiveMatrix BusinessWorks is installed. Stop all running processes in the 
installation environment before the installation.

Installation 
Mode

Description Reference

GUI In GUI mode, the installer contains panels where you can 
select a product, product location, and so on. To invoke the 
installer in GUI mode, double-click the executable file.

Installing in 
GUI Mode

Console In console mode, you can run the installer on a command 
line. This is useful if your machine does not have a GUI 
environment.

Installing in 
Console 
Mode

Silent In silent mode, the installer installs the product without 
prompting you for information. The installer uses either 
default or custom settings that are saved in a response file.

Installing in 
Silent Mode

Installing in GUI Mode
In GUI mode, the installer prompts you for information regarding the installation 
environment, installation profile, and other installation information.

Before you begin
 1. Ensure that ActiveMatrix BusinessWorks is already installed. The plug-in must be 

installed in the same installation environment where ActiveMatrix BusinessWorks is 
installed.

 2. Download the installation package from      TIBCO eDelivery. To download the 

https://edelivery.tibco.com/
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installation package, the TIBCO account credentials (username and password) are 
required. If you do not have a username and password, contact TIBCO Support.    

 3. Extract the content of the package to a local directory. 

 4. Stop all running processes in the installation environment.

Procedure
 1. Go to the       directory where you extracted the package.

 2. To start the installation, run the executable file of the TIBCO Universal Installer for 
the required platform.

 3. On the      Welcome page of the installation wizard, click      Next.      

 4. Accept the license agreement and click      Next.      

 5. On the      Installation Profile Selection page, select      Use an existing TIBCO_HOME and 
choose the installation environment where ActiveMatrix BusinessWorks is installed. 
Then, click      Next. For more information, see Installation Environment.

 6. On the      Installation Profile Selection page, select an installation profile to specify 
the components to be installed. Or select the      Customize Installation checkbox to 
select the installation components. Click Next. For more information, see Installation 
Components and Profiles. 

 7. On the      Pre-Install Summary page, review the information and click      Next.      

 8. On the      Post-Install Summary page, review the installation details and click      Finish.

What to do next
Open TIBCO Business Studio for BusinessWorks and create a project to start using the plug-
in. For more information, see the TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change 
Data Capture User Guide.

Installing in Console Mode
In console mode, you can run the installer from the command line. The installer prompts 
for values on a console window and you can move through the installation by responding 
to the prompts.

http://www.tibco.com/services/support
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Before you begin
 1. Ensure that ActiveMatrix BusinessWorks is already installed. The plug-in must be 

installed in the same installation environment where ActiveMatrix BusinessWorks is 
installed.

 2. Download the installation package from      TIBCO eDelivery. To download the 
installation package, the TIBCO account credentials (username and password) are 
required. If you do not have a username and password, contact TIBCO Support.    

 3. Extract the content of the package to a local directory. 

 4. Stop all running processes in the installation environment.

Procedure
 1. On a command line, go to the local directory where you extracted the installation 

package.      

 2. To start the installation, run the following command:             

<TIBCO Universal Installer executable file> -console

 3. Respond to the messages on the command line.      

The installation options are the same as GUI mode. For more information, see      
Installing in GUI Mode.

 4. When the installation is completed, press Enter to exit the installer.

What to do next
Open TIBCO Business Studio for BusinessWorks and create a project to start using the plug-
in. For more information, see the TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change 
Data Capture User Guide.

Installing in Silent Mode
In silent mode, you can run the installer without user input by pointing the installer to an 
existing response file. A default response file named TIBCOUniversalInstaller_
bwplugincdc_<plugin_version>.silent is packaged with the TIBCO Universal Installer. 
Before launching the silent installation, you must edit the response file with the 

https://edelivery.tibco.com/
http://www.tibco.com/services/support
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information about your environment. Ensure that you make a copy of the default response 
file then edit that file and use it for the installation.

• If you invoke the installer with the -silent argument, the installer reads the input 
from the default response file.

• If you invoke the installer with the -silent -V responseFile=<filename> 
argument, the installer reads the input from the specified response file.

Before you begin
 1. Ensure that ActiveMatrix BusinessWorks is already installed. The plug-in must be 

installed in the same installation environment where ActiveMatrix BusinessWorks is 
installed.

 2. Download the installation package from      TIBCO eDelivery. To download the 
installation package, the TIBCO account credentials (username and password) are 
required. If you do not have a username and password, contact TIBCO Support.    

 3. Extract the content of the package to a local directory. 

 4. Stop all running processes in the installation environment.

Procedure
 1. On the command line, go to the local directory where you extracted the installation 

package.     

 2. To start the installation, run the following command:

<TIBCO Universal Installer executable file> -silent -V responseFile="<my_
response_filename>"

Note: If you copy the response file to another directory and not the local 
directory containing the installer, then provide the absolute path of the 
response file.

What to do next
Open TIBCO Business Studio for BusinessWorks and create a project to start using the plug-
in. For more information, see the TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change 
Data Capture User Guide.

https://edelivery.tibco.com/
http://www.tibco.com/services/support
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Installing by Using an Update Site
You can install the  plug-in in the following ways. For details about installation procedures, 
see the Installation guide provided with the respective plug-in.

Installation 
method        

Description        Reference

Public update 
site       

You can install the plug-in from within        TIBCO 
Business Studio for BusinessWorks by using the 
public update site.         

Installing the Plug-
in by Using the 
Public Update Site

Local update site
       or directory

You can install the plug-in from within        TIBCO 
Business Studio for BusinessWorks by using a local 
update site or a shared directory managed by your 
organization.         

Installing the Plug-
in by Using a Local 
Update Site or 
Directory

BusinessWorks 
Plug-ins Manager

You can install the plug-in from within        TIBCO 
Business Studio for BusinessWorks using the 
BusinessWorks Plug-ins Manager.        

Installing the Plug-
in by Using 
BusinessWorks 
Plug-ins Manager

Installing the Plug-in by Using the Public 
Update Site
 You can install plug-ins from within TIBCO Business Studio for BusinessWorksby using the 
public update site maintained by TIBCO.

Before you begin
Ensure that design time is supported for your operating system platform.

Procedure



TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture Installation

15 | Installing by Using an Update Site

 1. Depending on the platform applicable to your plug-in, start TIBCO Business Studio 
for BusinessWorks:

Platform        Step        

Microsoft 
Windows        

Click          Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business 
Studio          <studio_version> > Studio for Designers

Linux or 
macOS        

Run the          TIBCO Business Studio for BusinessWorks executable file in the         
TIBCO_HOME/studio/<studio_version>/eclipse directory.        

For the list of platforms supported by your plug-in, see the Readme file.

 2. On the menu bar, click     Help > Install New Software to open the installation wizard.      

 3. On the      Install page, in the Work with field, enter the URL of the public update site, 
http://update.tibco.com/eclipse/bw/<bw-version>. Here the two-digit bw-version at 
the end of the address reflects the version of your ActiveMatrix BusinessWorks you 
are using. 

You can save the URL by adding it to the list of available software sites using the      
TIBCO Business Studio for BusinessWorks menu      Window > Preferences > 
Install/Update > Available Software Sites.      

 4. From the list of available plug-ins, select the plug-in you want to install. Click      Next.      

Note: You can select more than one plug-in from the list to install multiple 
plug-ins at the same time.

 5. On the      Install Details page, review the components you want to install. Click      Next.      

 6. On the      Review Licenses page, review and accept the license agreement. 

 7. To start the installation, click      Finish. 

What to do next
Restart      TIBCO Business Studio for BusinessWorks to verify that the plug-in is installed 
successfully.    

https://docs.tibco.com/dyno/bwplugincdc/6.2.0/TIB_bwplugincdc_6.2.0_readme.txt
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Installing the Plug-in by Using a Local Update 
Site or Directory
You can install ActiveMatrix BusinessWorks Plug-in for Change Data Capturefrom within    
TIBCO Business Studio for BusinessWorks by using a local site or directory maintained by 
your organization. 

Before you begin
 l Ensure that you downloaded the software package from the TIBCO download site 

and stored it in an appropriate location, such as a local update site or a directory. 
The default package name has the TIB_bwplugincdc_<plugin_version>_
p2installer.zip format.

 l Ensure that design time is supported for your operating system platform.

Procedure
 1. Depending on the platform applicable to your plug-in, start TIBCO Business Studio 

for BusinessWorks:

Platform        Step        

Microsoft 
Windows        

Click          Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business 
Studio          <studio_version> > Studio for Designers

Linux or 
macOS        

Run the          TIBCO Business Studio for BusinessWorks executable file in the         
TIBCO_HOME/studio/<studio_version>/eclipse directory.        

For the list of platforms supported by your plug-in, see the Readme file.

 2. On the menu bar, click     Help >  Install New Software      to open the installation wizard.      

 3. On the      Install page, click      Add to add an update site you want to work with.     

Note: You can add only one update site at a time. Repeat the following 
steps to add multiple repositories that contain the downloaded software 
packages.    

https://docs.tibco.com/dyno/bwplugincdc/6.2.0/TIB_bwplugincdc_6.2.0_readme.txt
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 a. In the        Add Repository dialog, click Local or        Archive to locate the plug-in 
installation package you want to install, and then click        OK. 

 b. The selected plug-in installation package is added to the Location field. Click 
OK.     The plug-in installation package is added to the list of available software 
on the Install page. 

 4.  On the      Install page, select the plug-in you want to install. Click      Next.      

Note: You can select more than one plug-in from the list to install multiple 
plug-ins at the same time.      

 5. On the      Install Details page, review the components you want to install. Click      Next.      

 6.  On the      Review Licenses page, review and accept the license agreement. 

 7. To start the installation, click      Finish. 

What to do next
Restart      TIBCO Business Studio for BusinessWorks to verify that the plug-in is installed 
successfully.    

Installing the Plug-in by Using BusinessWorks 
Plug-ins Manager
You can install the plug-in from within    TIBCO Business Studio for BusinessWorks by using 
BusinessWorks Plug-ins Manager. TIBCO recommends that you use the same mode for 
installing and uninstalling the plug-in.

Before you begin
To install the plug-in by using the plug-ins manager, read the following considerations:

 l You must have version 6.8.0 or later of ActiveMatrix BusinessWorks. 

 l Ensure that design time is supported for your operating system platform.

The software package must be available at the update site: 

http://update.tibco.com/eclipse/bw/<bw-version>
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Here, the    bw-version at the end of the address reflects the version of ActiveMatrix 
BusinessWorks you are using. 

Procedure
 1. Depending on the platform applicable to your plug-in, start TIBCO Business Studio 

for BusinessWorks:

Platform        Step        

Microsoft 
Windows        

Click          Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business 
Studio          <studio_version> > Studio for Designers

Linux or 
macOS        

Run the          TIBCO Business Studio for BusinessWorks executable file in the         
TIBCO_HOME/studio/<studio_version>/eclipse directory.        

For the list of platforms supported by your plug-in, see the Readme file.

 2. Open BusinessWorks Plug-ins Manager in one of the following ways:      

 l On the menu bar, click      Help > BusinessWorks Plug-ins Manager.      

 l When a process is open, in the      Palette section (right pane), click the      Plug-ins 
Manager icon      .

The      BusinessWorks Plug-ins Manager dialog opens, listing all the plug-ins available on 
the public update site.

To open the documentation of a plug-in, on the plug-in tile, click the View 
documentation icon  or right-click and select the relevant option. 

https://docs.tibco.com/dyno/bwplugincdc/6.2.0/TIB_bwplugincdc_6.2.0_readme.txt
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 3. In the      BusinessWorks Plug-ins Manager dialog, select one or more plug-ins that you 
want to install, and then click      Install.

The list of plug-ins is displayed based on your selection of options on the      Options 
tab.

 4. In the Install wizard, perform the following steps: 

 a. On the        Install page, confirm that the required plug-ins are selected for 
installation and click        Next.      

 b. On the        Install Details page, review the plug-in details and click        Next.      

 c. To continue, accept the terms of agreement and click        Finish. 

What to do next
Restart      TIBCO Business Studio for BusinessWorks to verify that the plug-in is installed 
successfully.    
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Adding the Plug-in to TIBCO 
BusinessWorks™ Container Edition
To add the plug-in to TIBCO BusinessWorks™ Container Edition, you must perform the 
following steps:

Procedure
 1. Open the physical media or download the installation package from TIBCO eDelivery:

 l TIB_bwplugincdc_version_buildnumber_bwce-runtime.zip

To download the installation package, a username and password are required. If you 
do not have a username and password, contact TIBCO Technical Support.

 2. Based on the database you select, perform the following:

 l For DB2
Copy the com.tibco.tpshell.cdcdb2_6.1.0.XXX wrapper folder with the DB2 
libraries present in the 
bwce_home/palettes/cdc/<version_number>/runtime/plugins, to the 
resources/addons/jars location.

 l For SAP
Copy the com.tibco.tpshell.cdcsap_3.1.8.XXX wrapper folder with the SAP 
libraries present in the bwce_home/palettes/cdc/<version_
number>/runtime/plugins, to the resources/addons/jars location.

 3. Add the .zip file to TIBCO BusinessWorks™ Container Edition at run time.

For the procedure, see the following section in TIBCO BusinessWorks™ Container 
Edition Application Development:

Platform Reference

Docker or 
Docker-

Application Development for Docker section:

 l Creating the TIBCO BusinessWorks™ Container Edition Docker           

https://edelivery.tibco.com/
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Platform Reference

based 
platforms

Image

 l Extending the Base Docker Image > Provision the TIBCO 
BusinessWorks™ Container Edition Plug-in Runtime
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Uninstalling by Using the TIBCO Universal 
Installer
You can uninstall the plug-in by using the TIBCO Universal Installer. It can be done in the 
following modes: GUI, console, and silent.

Note: 
 l TIBCO recommends that you use the same mode for uninstallation that 

you used for installing the plug-in. Using different methods for installation 
and uninstallation might cause some problems during uninstallation.

 l Before uninstalling the plug-in, stop all running processes in the 
installation environment.

 l Uninstalling in GUI Mode

 l Uninstalling in Console Mode

 l Uninstalling in Silent Mode

Uninstalling in GUI Mode
You can uninstall all the products or specific products from a selected    TIBCO_HOME 
directory when using the TIBCO Universal Installer to uninstall the plug-in in GUI mode.

Note: 
 l TIBCO recommends that you use the same mode for uninstallation that 

you used for installing the plug-in. Using different methods for installation 
and uninstallation might cause some problems during uninstallation.

 l Before uninstalling the plug-in, stop all running processes in the 
installation environment.

Procedure
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 1. Go to the      TIBCO_HOME/tools/universal_installer directory.      

 2. Run the executable file of the TIBCO Universal Installer for the required platform.                

 3. On the      TIBCO Installation Manager page, select      Uninstall Products from a TIBCO 
Home Location.      

 4. From the      TIBCO Home Location list, select the      TIBCO_HOME directory where the 
product is installed. Click Next.

 5. On the  Welcome page, click Next.

 6. On the Uninstallation Type page, select an uninstallation option and click Next.

Option Description

Custom 
Uninstall

You can select the products to be removed.        

Typical 
Uninstall

You cannot select the products. All the products in the selected        TIBCO_
HOME directory are removed.

 7.  If you select      Custom Uninstall in the previous step, select the checkbox next to the 
product to be uninstalled in the      Product Uninstall Selection page. Click      Next. 

 8. On the      Pre-Uninstall Summary page, review the product to be uninstalled. Click      
Uninstall.      

 9. On the      Post-Uninstall Summary page, click      Finish to complete the uninstallation 
process and exit the installer.      

 10.  If you have uninstalled all the software in the selected      TIBCO_HOME directory, delete 
the folders in the installation environment and user home. 

What to do next
After you have uninstalled all the software in the selected TIBCO_HOME directory, delete 
the residual folders (if any) in the installation environment and user home.     
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Uninstalling in Console Mode
If you are not working in a GUI environment, you can uninstall the software in console 
mode.

Note: 
 l TIBCO recommends that you use the same mode for uninstallation that 

you used for installing the plug-in. Using different methods for installation 
and uninstallation might cause some problems during uninstallation.

 l Before uninstalling the plug-in, stop all running processes in the 
installation environment.

Procedure
 1. On a command line, go to the      TIBCO_HOME/tools/universal_installer directory.      

 2. To start the uninstallation, run the following command:

<TIBCO Universal Installer executable file> -console

 3. Respond to the messages on the command line.      

The uninstallation options are the same as GUI mode. For more information, see      
Uninstalling in GUI Mode.      

 4. When the uninstallation is completed, press Enter to exit the installer.      

Uninstalling in Silent Mode
In silent mode, you can uninstall the product from the command line.
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Note: 
 l TIBCO recommends that you use the same mode for uninstallation that 

you used for installing the plug-in. Using different methods for installation 
and uninstallation might cause some problems during uninstallation.

 l Before uninstalling the plug-in, stop all running processes in the 
installation environment.

Before you begin
 1. Go to the local directory where you extracted the installation package.

 2. Copy the TIBCOUniversalInstaller_bwplugincdc_<plugin_version>.silent 
response file to the TIBCO_HOME/tools/universal_installer directory, rename the 
file to mysilent.silent, and remove the existing entries in the mysilent.silent file.

 3. Add the following parameters to the    mysilent.silent file by using the <entry 
key="keyname">keyvalue</entry> syntax: 

<entry key="uninstallProductID">bwplugincdc</entry> 
 <entry key="uninstallProductVersion">6.x.x</entry>
 <entry key="uninstallTIBCOHome">c:/tibco</entry>

Procedure
 1. Go to the      TIBCO_HOME/tools/universal_installer directory.      

 2. Run the following command:     

<TIBCO Universal Installer executable file> -silent -V responseFile="<my_
response_filename>"

Note: If you copy the response file to another directory and not the local 
directory containing the installer, then provide the absolute path of the 
response file.

 3. You can also use the command-line options to override the value in the silent file. 
The following options are supported:      

 l -V uninstallTIBCOHome="<TIBCO_HOME path>"
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 l -V uninstallProductID="<productID>"

 l -V uninstallProductVersion="<product version>"

 l -V uninstallAllProducts="true"

Command-Line Options        Description        

uninstallTIBCOHome The path to          TIBCO_HOME where you want to run the 
uninstaller. This value is validated before the 
uninstallation can proceed in silent mode.        

uninstallProductID The ID of the product that you want to uninstall as 
defined in the feature          config          or          _installInfo xml file. 
A wildcard ("*") can be used to uninstall all products. 
The          uninstallAllProducts="true" option must be 
used to uninstall all products.        

uninstallProductVersion The version of the product that you specified with the          
uninstallProductID value. If not specified, all versions 
matching the          uninstallProductID are removed.        

uninstallAllProducts This option must be used in addition to setting          
uninstallProductID="*" in the silent file to uninstall 
all products.        
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Uninstalling by Using an Update Site
You can uninstall the plug-in in the following ways. For details about uninstallation 
procedures, see the Installation guide provided with the respective plug-in. 

Uninstallation 
method        

Description        Reference

Uninstall using 
the public update 
site       

You can uninstall the plug-in from within        
TIBCO Business Studio for BusinessWorks by 
using the public update site.         

Uninstalling the Plug-in 
by Using the Public 
Update Site or Local 
Update Site

Uninstall using 
BusinessWorks 
Plug-ins Manager

You can uninstall the plug-ins from within        
TIBCO Business Studio for BusinessWorks by 
using the BusinessWorks Plug-ins Manager.        

Uninstalling the Plug-in 
by Using BusinessWorks 
Plug-ins Manager

Uninstalling the Plug-in by Using the Public 
Update Site or Local Update Site
You can uninstall the plug-in from within    TIBCO Business Studio for BusinessWorks by 
using the public update site maintained by TIBCO.

Note: TIBCO recommends that you use the same mode for uninstallation that 
you used for installing the plug-in. Using different methods for installation and 
uninstallation might cause some problems during uninstallation.

Before you begin
Depending on the platform applicable to your plug-in, start TIBCO Business Studio for 
BusinessWorks:
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Platform        Step        

Microsoft 
Windows        

Click          Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business Studio          
<studio_version> > Studio for Designers

Linux or 
macOS        

Run the          TIBCO Business Studio for BusinessWorks executable file in the         TIBCO_
HOME/studio/<studio_version>/eclipse directory.        

For the list of platforms supported by your plug-in, see the Readme file.

Procedure
 1. On the menu bar, select      Help > About TIBCO Business Studio for BusinessWorks.      

 2. Click     Installation Details.

The TIBCO Business Studio for BusinessWorks(TM) Installation Details dialog is 
displayed.

 3. Select the plug-in to uninstall and click Uninstall.

 4. On the      Uninstall Details page, review the items to uninstall and click      Finish.      

What to do next
Restart      TIBCO Business Studio for BusinessWorks to verify that the plug-in is uninstalled 
successfully.    

Uninstalling the Plug-in by Using 
BusinessWorks Plug-ins Manager
You can uninstall the  plug-in from within TIBCO Business Studio for BusinessWorks by 
using BusinessWorks Plug-ins Manager.    

Note: TIBCO recommends that you use the same mode for uninstallation that 
you used for installing the plug-in. Using different methods for installation and 
uninstallation might cause some problems during uninstallation.

https://docs.tibco.com/dyno/bwplugincdc/6.2.0/TIB_bwplugincdc_6.2.0_readme.txt
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Before you begin
Depending on the platform applicable to your plug-in, start TIBCO Business Studio for 
BusinessWorks:

Platform        Step        

Microsoft 
Windows        

Click          Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business Studio          
<studio_version> > Studio for Designers

Linux or 
macOS        

Run the          TIBCO Business Studio for BusinessWorks executable file in the         TIBCO_
HOME/studio/<studio_version>/eclipse directory.        

For the list of platforms supported by your plug-in, see the Readme file.

Procedure
 1. On the menu bar, click Help > BusinessWorks Plug-ins Manager. 

Optionally, click the Plug-ins Manager icon  in the Palette section.

The      BusinessWorks Plug-ins Manager dialog opens, listing all the plug-ins available on 
the public update site.      

 2. On the      Options tab, select the     Show only installed plug-ins checkbox and select the 
plug-ins to uninstall.      

 3. Click Uninstall. 

The Uninstall Details dialog is displayed. 

https://docs.tibco.com/dyno/bwplugincdc/6.2.0/TIB_bwplugincdc_6.2.0_readme.txt
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 4. In the        Uninstall Details dialog, review the components to uninstall.      

 5. To start the plug-ins uninstallation, click        Finish.      

What to do next
Restart      TIBCO Business Studio for BusinessWorks to verify that the plug-in is uninstalled 
successfully.    
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Postinstallation Tasks
This section provides information on required steps following the installation of the plug-
in. For the CDC-DB Listener activity, additional steps are required for database DB2. For the 
CDC-SAP Listener activity, additional steps are always required.

DB2 Driver Installation

To install ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture for DB2 database 
with CDC-DB Listener activity perform the following steps.

Procedure
 1. On a command line, go to the <TIBCO_HOME>/bw/palettes/cdc/<version_

number>/bin directory.

 2. Run the installer using the following command:            

cdcinstall db2-driver

 3. On the command line, enter the location of the DB2 driver folder.        

The installation procedure is the same for GUI, console, and silent mode. 

 4. When the installation is completed, press Enter to exit the installer.

SAP JCo Libraries Installation

To install ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture for SAP database 
with CDC-SAP Listener activity perform the following steps.

Procedure
 1. On a command line, go to the <TIBCO_HOME>/bw/palettes/cdc/<version_

number>/bin directory.      

 2. Run the installer using the following command:            
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cdcinstall sap-driver

 3. On the command line, enter the location of the SAP JCo libraries folder.        

The installation procedure is the same for GUI, console, and silent mode. 

 4. When the installation is completed, press Enter to exit the installer.

Updating the SAP JCo Libraries

If using the CDC-SAP Listener activity, the SAP JCo libraries need to be updated after the 
plug-in installation and then perform the following steps.

Before you begin
Install the existing version of ActiveMatrix BusinessWorks™ Plug-in for Change Data 
Capture. Ensure that the sapjco3.jar and corresponding library are present on the local 
machine.

Procedure
 1. Go to the bin folder where the plug-in is installed. For example, C:\TIBCO_

HOME\bw\palettes\cdc\<version_number>\bin.      

 2. On the command line, enter the following commands:            

 l For Windows

cdcinstall.exe sap-driver

 l For Linux or Unix

./cdcinstall sap-driver

 l For macOS

./cdcinstall sap-driver

 3. On running the command, the following message is displayed

Please specify absolute path of the SAP JCo libraries:
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 4. Specify the absolute path of the SAP JCo libraries folder where the sapjco3.jar and 
corresponding library ęles are present. 

For example, sapjco3.jar and a corresponding library is present in, D:\Installer 
and then you populate the path. 

A BUILD SUCCESSFUL message is displayed, which indicates the SAP JCo libraries are 
updated successfully.       

 5. If updating the SAP JCo libraries in a deployed environment, a further step is 
required so that the update is successful.

 a. Set the bw.appnode.clean.config.folder.on.startup property as true in the 
config.ini file of appnode.

What to do next
Restart TIBCO Business Studio and SAP Plug-in applications.
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Configuring Databases
You can configure Apache Cassandra, IBM DB2, MongoDB, MSSQL, MySQL, Oracle Database, 
and PostgreSQL with ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture using 
this section.

Enabling CDC on IBM DB2 database

To enable ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture on DB2 SSH into 
the machine with username, perform the following steps.

Procedure
 1. Start the IBM DB2 database. You can use the following command:

db2  start db <DB_NAME>

 2. Connect the DB and confirm that you can read the metadata catalog. You can use the 
following command:

db2 connect to <DB_NAME>
db2 bind db2schema.bnd

blocking all grant public sqlerror continue

The output should be:

db2 bind db2schema.bnd blocking all grant public sqlerror continue
LINE    MESSAGES FOR db2schema.bnd
------  ---------------------------------------------------
SQL0061W  The binder is in progress.
SQL0091N  Binding was ended with "0" errors and "0" warnings.
The command must finish with 0 errors and 0 warnings.

 3. Back up the database:

db2 backup db <DB_NAME> to location /dev/null
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 4. Restart DB and connect to it.

db2 restart db <DB_NAME>
db2 connect to <DB_NAME>

 5. Create CDC database objects by running the SQL scripts in:
Create CDC tables Script. Refer the script file at the path <TIBCO_
HOME>\bw\palettes\cdc\<version_number>\samples\scripts.zip.

 6. Check the status of CDC service on the database side by running the command:

asnccmd capture_schema=ASNCDC capture_server=<db_name> status

In DB2 by default, CDC artifacts are created in ASNCDC schema. Ideally the following 
output is observed for the above command:

2023-09-18-18.46.58.952383 ASN0520I  "AsnCcmd" : "ASNCDC" : 
"Initial" : The STATUS command response: "WorkerThread" thread is 
in the "is doing work" state.
2023-09-18-18.46.58.952395 ASN0520I  "AsnCcmd" : "ASNCDC" : 
"Initial" : The STATUS command response: "LogrdThread" thread is in 
the "is doing work" state.
The worker thread and the log read thread (LogrdThread) should be 
in ‘is doing work’ state.

 7. If the above command times out without displaying the above output, start the 
service with the command below:

asncap capture_schema=ASNCDC capture_server=db_name &
The output for this command must show the number of active and 
inactive entities.
ASN0109I  CAPTURE "ASNCDC" : "WorkerThread". The Capture program 
has successfully initialized and is capturing data changes for "4" 
registrations. "0" registrations are in a stopped state. "1" 
registrations are in an inactive state.

 8. Add desired table to capture mode by running the stored procedure from the SQL 
client, the script file located at <TIBCO_HOME>\bw\palettes\cdc\<version_
number>\samples\scripts.zip:
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CALL CDCPLUGIN.ADDTABLE(<actual_schema>, <table_name>);
Example:
CALL CDCPLUGIN.ADDTABLE(‘BANK’, ‘HOLDING’);

 9. Reinitialize the CDC service by running the following command:

 10. Now data can be inserted/updated into the table or deleted from the table (for 
example: BANK.HOLDING) and data changes can be polled.

 11. If the table needs to be removed from CDC, call the following stored procedure from 
SQL client, script file located at <TIBCO_HOME>\bw\palettes\cdc\<version_
number>\samples\scripts.zip:

CALL CDCPLUGIN.REMOVETABLE(<actual_schema>, <table_name>);
Example:
CALL CDCPLUGIN.REMOVETABLE(‘BANK’, ‘HOLDING’);
Then ‘reinit’ the CDC service and ensure that the worker thread and 
log read thread are in ‘doing work’ state.

Note: Whenever the status command or reinit command times out, restart 
the CDC service as explained in the step: 7

Enabling CDC on PostgreSQL database

To enable ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture on PostgreSQL, 
after the plug-in installation is complete, ensure that the database is up and running. To 
conduct change data capture operations, create a new user role apart from SUPERUSER.

Procedure
 1. Create a user/role for CDC.

 2. Grant the role with LOGIN, SELECT, CERATE and REPLICATION privileges.

 3. Create a new password for the role.

 4. Go to <path_to>/postgres/<version_number>/main/postgresql.conf and open the 
file and perform the following operations:

For ‘listen_address’, set the value to ‘*’:
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listen_address= ‘*’

Move to the ‘WRITE-AHEAD Log’ section and set:

wal_level = logical

Move to the ‘REPLICATION’ section and set:

max_wal_senders = 4

At the end of the file, create a section called ‘MODULES’ and set:

shared_preload_libraries = ‘pgoutput’

 5. Open the file, pg_hba.conf located at <path_to_postgres>/postgres/<version_
number>/main

 6. Go to the replication privileges section at the end of the file:

 l Make sure that the entries are consistent with the following and add a row for 
the CDC db user at the end:

=============================================
#Allow replication connections from localhost, by a user with 
the
# replication privilege.

local   replication   all                      trust
local   replication   all       127.0.0.1/32   trust
host    replication   all                      trust
host    all           all           all       md5
#host   all           all           ::/0
host    replication   <cdc_db_user> 0.0.0.0/0  trust            

To add a table in the Replication mode, run the following SQL command:

ALTER TABLE <schema_name.db_name> replica identity FULL; 
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Enabling CDC on MySQL

To enable ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture on MySQL, alter 
root user and set a password.

ALTER USER 'root'@'localhost' IDENTIFIED WITH mysql_native_password BY 
'<password_for_root>

Procedure
 1. Create a user for CDC and grant all privileges on all databases.

CREATE USER '<user_for_cdc>'@'%' IDENTIFIED BY '<cdc_password>';
Grant all privileges on *.*;
Flush privileges;
Exit;

 2. The minimum set of privileges required for replication is:

Grant select, show databases, replication slave, replication client 
on *.* to ‘<cdc_db_user>’;

 3. Go to the directory: <path_to>/mysql/mysql.conf.d

 4. Open the mysqld.cnf file.

 5. Ensure to uncomment:

Port = 3306
Set bind-address = 0.0.0.0

 6. Edit and set the following for replication at the end of the file:

server-id  = 1
log_bin   = /var/log/mysql/mysql-bin.log
binlog_expire_logs_seconds = 2592000
max_binlog_size   = 100M
binlog_format = row
default_authentication_plugin = mysql_native_password

The binlog size can be updated based on your preference.
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 7. Save the file and restart the DB
Verify the status:
Expected  - Active and Running.

For example, the following is the command for Linux

sudo systemctl status mysql 

The server_id can also be queried on the Mysql prompt: select @@server_id;

 8. Check the following variables:

a. mysql> SELECT FROM performance_schema.global_variables WHERE 
variable_name='log_bin'; 
SELECT variable_value AS ‘BINARY_LOGGING_STATUS (log-bin) ::”
FROM performance_schema.global_variables variable_name = ‘log_bin’;
This should return ‘ON’

b. SHOW global_variables WHERE variable_name = ‘binlog_row_value_
options’;
The value returned should be empty. If not explicitly set empty 
value by executing:
set @@binlog_row_value_options=””;

Enabling CDC on MSSQL

To enable ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture on MSSQL, verify 
the following permissions:

 l The user should be part of the db_owner role for the CDC database.

 l The user should have select grant on all captured DB objects.

 l The members of the db_owner role can view information on all captured instances.

Enabling CDC on Database

The system stored procedures should be run from SQL Server Management Studio.

Procedure
 1. From SQL Server Management Studio, select the View menu.

 2. Click Template Explorer.
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 3. Expand SQL Server Templates.

 4. Expand Change Data Capture, expand the Configuration option and then select 
Enable Database for CDC.

 5. Run the stored procedure sys.sp_cdc_enable_db to enable the database for CDC 
after replacing the DB name in the USE statement at the top.

Enabling CDC for Each Table

Procedure
 1. Navigate to SQL Server Management Studio > Template Explorer > expand SQL 

Server Templates.

 2. Expand Change Data Capture, expand Configuration option, and select Enable Table 
Specifying Filegroup option.

 3. Replace the table name in the USE statement with the name of the table that requires 
CDC enabled, and run the stored procedure sys.sp_cdc_enable_table.

The filegroup where SQL Server saves the CDC information for the selected table 
must already be present.

Enabling CDC on Oracle

To enable ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture on Oracle server 
perform the following steps:

Procedure
 1. Open the new SQL Plus and run the following queries:

Enter user-name: '/' as sysdba 

SQL> show con_name; 
CON_NAME
------------------------------
CDB$ROOT
SQL> show pdbs; 
CON_ID CON_NAME          OPEN MODE  RESTRICTED
------------------------------
2 PDB$SEED             READ ONLY  NO 
3 ORCLPDB              READ WRITE NO
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SQL> shutdown immediate;
Database closed.
Database dismounted.
ORACLE instance shut down.

SQL> startup;
ORACLE instance started.
Total System Global Area 1.0335E+10 bytes

Fixed Size         12816984 bytes
Variable Size      1577058304 bytes
Database Buffers   8724152320 bytes
Redo Buffers       20733952 bytes
Database mounted.
Database opened.

SQL> show pdbs;
CON_ID CON_NAME    OPEN MODE  RESTRICTED
---------- ------------------------------ ----------
2 PDB$SEED         READ ONLY  NO
3 ORCLPDB          READ WRITE NO

SQL> show parameter recovery;
NAME        TYPE        VALUE
------------------------------------
db_recovery_file_dest         string
db_recovery_file_dest_size    big integer   0
recovery_parallelism          integer       0
remote_recovery_file_dest     string        0

SQL> alter system set db_recovery_file_dest_size = 20G;
System altered.

SQL> alter system set db_recovery_file_dest = 
'C:\oracle19c\oradata\ORCL\recovery_area' scope=spfile;
System altered.
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SQL> alter system set db_recovery_file_dest = 
'C:\oracle19c\oradata\ORCL\recovery_area' scope=spfile;
System altered.

SQL> shutdown immediate;
Database closed.
Database dismounted.
ORACLE instance shut down.

SQL> startup mount;
ORACLE instance started.
Total System Global Area 1.0335E+10 bytes
Fixed Size         12816984 bytes
Variable Size      1577058304 bytes
Database Buffers   8724152320 bytes
Redo Buffers       20733952 bytes

Database mounted.

SQL> archive log list;
Database log mode            No Archive Mode
Automatic archival           Disabled
Archive destination          USE_DB_RECOVERY_FILE_DEST
Oldest online log sequence   1
Current log sequence         2

SQL> alter database archivelog;
Database altered.

SQL> archive log list;
Database log mode             Archive Mode
Automatic archival            Enabled
Archive destination           USE_DB_RECOVERY_FILE_DEST
Old online log sequence       1
Next log sequence to archive  2
Current log sequence          2
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SQL> show pdbs;
CON_ID CON_NAME      OPEN MODE  RESTRICTED
---------- ------------------------------ 
2 PDB$SEED           MOUNTED
3 ORCLPDB            MOUNTED

SQL> alter database open;
Database altered.

SQL> show pdbs;
CON_ID CON_NAME       OPEN MODE  RESTRICTED
---------- ------------------------------ 
2 PDB$SEED            READ ONLY  NO
3 ORCLPDB             READ WRITE NO

SQL> archive log list;
Database log mode             Archive Mode
Automatic archival            Enabled
Archive destination           USE_DB_RECOVERY_FILE_DEST
Old online log sequence       1
Next log sequence to archive  2
Current log sequence          2

SQL> show parameter recovery;
NAME           TYPE        VALUE
------------------------------------ 
db_recovery_file_dest string very_area C:\oracle19c\oradata\ORCL\reco
db_recovery_file_dest_size   big integer 20G
recovery_parallelism         integer      0
remote_recovery_file_dest    string

SQL> select log_mode from v$database;
LOG_MODE
------------
ARCHIVELOG

SQL> alter database add supplemental log data;
Database altered.
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SQL> commit;
Commit complete.

SQL> SELECT GROUP#, BYTES/1024/1024 SIZE_MB, STATUS FROM V$LOG 
ORDER BY 1;
GROUP#    SIZE_MB STATUS
---------- ---------- ----------
1        200 INACTIVE
2        200 CURRENT
3        200 UNUSED

SQL> SELECT GROUP#, MEMBER FROM V$LOGFILE ORDER BY 1, 2;
GROUP#
----------
MEMBER
---------------------------
 1
C:\ORACLE19C\ORADATA\ORCL\REDO01.LOG
 2
C:\ORACLE19C\ORADATA\ORCL\REDO02.LOG
 3
C:\ORACLE19C\ORADATA\ORCL\REDO03.LOG

SQL> ALTER DATABASE CLEAR LOGFILE GROUP 1;
Database Altered

SQL> ALTER DATABASE CLEAR LOGFILE GROUP 1;
Database Altered

SQL> ALTER DATABASE ADD LOGFILE GROUP 1 
('C:\ORACLE19C\ORADATA\ORCL\REDO01.LOG') size 5G REUSE;
Database Altered

SQL> SELECT GROUP#, BYTES/1024/1024 SIZE_MB, STATUS FROM V$LOG 
ORDER BY 1;

GROUP#    SIZE_MB STATUS
---------- ---------- ----------------
1       5120 UNUSED
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2        200 CURRENT
3        200 UNUSED

SQL> SELECT GROUP#, BYTES/1024/1024 SIZE_MB, STATUS FROM V$LOG 
ORDER BY 1;

GROUP#    SIZE_MB     STATUS
---------- ---------- ----------------
1          5120       UNUSED
2          200        CURRENT
3          200        UNUSED

Note: Change Group 3 first, as Group 2 is currently in use and its status is 
CURRENT.

SQL> ALTER DATABASE CLEAR LOGFILE GROUP 3;
Database altered.

SQL> ALTER DATABASE DROP LOGFILE GROUP 3;
Database altered.

SQL> ALTER DATABASE ADD LOGFILE GROUP 3 
('C:\ORACLE19C\ORADATA\ORCL\REDO03.LOG') size 5G REUSE;
Database altered.

SQL> SELECT GROUP#, BYTES/1024/1024 SIZE_MB, STATUS FROM V$LOG 
ORDER BY 1;
GROUP#    SIZE_MB STATUS
---------- ---------- ----------------
1       5120 UNUSED
2        200 CURRENT
3       5120 UNUSED

SQL> ALTER SYSTEM SWITCH LOGFILE;
System altered.
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SQL> SELECT GROUP#, BYTES/1024/1024 SIZE_MB, STATUS FROM V$LOG 
ORDER BY 1;

GROUP#    SIZE_MB STATUS
---------- ---------- ----------------
1       5120 CURRENT
2        200 ACTIVE
3       5120 UNUSED

Note: Now here the status of the Group 1 log file is changed from UNUSED 
to CURRENT. Now we can change the size of the Group 2 logfile. We now 
need to wait for the database to eventually switch the status of log group 
2 to INACTIVE.

SQL> SELECT GROUP#, BYTES/1024/1024 SIZE_MB, STATUS FROM V$LOG 
ORDER BY 1;

GROUP#    SIZE_MB STATUS
---------- ---------- ----------------
1       5120 CURRENT
2        200 INACTIVE
3       5120 UNUSED

SQL> ALTER DATABASE CLEAR LOGFILE GROUP 2;
Database altered

SQL> ALTER DATABASE DROP LOGFILE GROUP 2;
Database altered

SQL> ALTER DATABASE ADD LOGFILE GROUP 2 
('C:\ORACLE19C\ORADATA\ORCL\REDO02.LOG') size 5G REUSE;
Database altered

SQL> SELECT GROUP#, BYTES/1024/1024 SIZE_MB, STATUS FROM V$LOG 
ORDER BY 1;
GROUP#    SIZE_MB STATUS
---------- ---------- ----------------
1       5120 CURRENT
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2       5120 UNUSED
3       5120 UNUSED

SQL> commit;
Commit complete.

SQL> show con_name;
CON_NAME
------------------------------
CDB$ROOT

SQL> CREATE TABLESPACE logminer_tbs DATAFILE 
'C:\oracle19c\oradata\ORCL\orclpdb\logminer_tbs.dbf' SIZE 25M REUSE 
AUTOEXTEND ON MAXSIZE UNLIMITED;
Tablespace created.

SQL> alter session set "_ORACLE_SCRIPT"=TRUE;
Session altered

SQL> alter user sys identified by <SYS_USER_PASSWORD>;
User altered.

SQL> CREATE USER c##dbzuser IDENTIFIED BY <PASSWORD> DEFAULT 
TABLESPACE LOGMINER_TBS QUOTA UNLIMITED ON LOGMINER_TBS 
CONTAINER=ALL;
User created.

SQL> GRANT CREATE SESSION TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT SET CONTAINER TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT FLASHBACK ANY TABLE TO c##dbzuser CONTAINER=ALL;
Grant succeeded.
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SQL> GRANT SELECT ANY TABLE TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT EXECUTE_CATALOG_ROLE TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT SELECT ANY TRANSACTION TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT SELECT ANY DICTIONARY TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT LOGMINING TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT CREATE TABLE TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT LOCK ANY TABLE TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT CREATE SEQUENCE TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT EXECUTE ON DBMS_LOGMNR TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT EXECUTE ON DBMS_LOGMNR_D TO c##dbzuser CONTAINER=ALL
Grant succeeded.

SQL>GRANT SELECT ON V_$LOG TO c##dbzuser CONTAINER=ALL;
Grant succeeded.
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SQL> GRANT SELECT ON V_$LOG_HISTORY TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT SELECT ON V_$LOGMNR_LOGS TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT SELECT ON V_$LOGMNR_CONTENTS TO c##dbzuser 
CONTAINER=ALL;
Grant succeeded.

SQL> GRANT SELECT ON V_$LOGMNR_PARAMETERS TO c##dbzuser 
CONTAINER=ALL;
Grant succeeded.

SQL> GRANT SELECT ON V_$LOGFILE TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT SELECT ON V_$ARCHIVED_LOG TO c##dbzuser CONTAINER=ALL;
Grant succeeded.

SQL> GRANT SELECT ON V_$ARCHIVE_DEST_STATUS TO c##dbzuser 
CONTAINER=ALL;
Grant succeeded.

SQL> commit;
Grant succeeded.

Enabling CDC on MongoDB

To enable ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture on MongoDB, 
perform the following steps:

Procedure
 1. Start MongoDB as a replica set.

Debezium requires MongoDB to run as a replica set, even for a single node.
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 l For a single node:

mongod --replSet rs0 --bind_ip localhost

 l For SSL connections:

mongosh --tls --host localhost --tlsCAFile C:\yourPath\ca.crt 
--tlsCertificateKeyFile C:\yourPath\mongodb.pem --port 
portNumber

 2. Initialize the replica set.

 a. Connect to the MongoDB shell.

 b. Run the following command:

rs.initiate()

 c. Create a Debezium user with the required permissions.

In the MongoDB shell, create a user with the necessary roles:

use admin
 db.createUser({
   user: "debezium",
   pwd: "dbz",
   roles: [
  { role: "read", db: "your_database" },
  { role: "readAnyDatabase", db: "admin" },
  { role: "clusterMonitor", db: "admin" }
       ]
 })

Replace your_database with the name of the database from which you want to 
capture changes.

Enabling CDC on Apache Cassandra 4.x

To enable ActiveMatrix BusinessWorks™ Plug-in for Change Data Capture on Apache 
Cassandra 4.x, perform the following steps:

Procedure
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 1. Enable CDC in the cassandra.yaml configuration.

 a. Open your Cassandra node's cassandra.yaml file.

 b. Find the following line:

cdc_enabled: false

 c. Change it to:

cdc_enabled: true

 2. Restart Cassandra.

Run the Cassandra script from the installation directory:

bin/cassandra -f

 3. To enable CDC on specific tables.

Note: By default, CDC is not enabled for any table. You must enable it for 
each table individually using CQL.

 a. Connect to cqlsh.

cqlsh

 b. Create a keyspace with CDC enabled:

CREATE KEYSPACE testks

WITH replication = {'class': 'SimpleStrategy', 'replication_
factor': 1};

 c. Use the keyspace:

USE testks;

 d. Create a table with CDC enabled:
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CREATE TABLE users (
  user_id uuid PRIMARY KEY,
  name text,
  email text
  ) WITH cdc = true;

 e. Verify that CDC is enabled.

Run the following command and look for cdc: true in the output:

DESCRIBE TABLE testks.users;
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Reconnecting Database using HBTable
When the connection between the database and the plug-in is interrupted, the plug-in can 
be reconnected to the database using a heartbeat table. This heartbeat table is configured 
using the module properties. 
For more information about module properties, see the "Support of Database 
Reconnection" section in TIBCO ActiveMatrix BusinessWorks™ Plug-in for Change Data 
Capture User Guide.

To enable this heartbeat table, run the SQL scripts for the required database located at the 
path <TIBCO_HOME>\bw\palettes\cdc\<version_number>\samples\scripts.zip.
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Troubleshooting Installation
If you encounter problems with the installation or uninstallation, first ensure that your 
system meets all the requirements. Then, check the installer log for potential problems.    

Depending on the platform applicable to your plug-in, select the location of the installer 
log file. The installer log file,    tibco_universal_installer.username_install.log, is 
available at the following locations:      

Platform        Location       

Microsoft Windows        C:\Users\username\.TIBCO\install_timestamp

Linux        user_home_dir/.TIBCO/install_timestamp

macOS Users/user_home_dir/.TIBCO/install_timestamp

The installer log file captures the following information:    

 l Detailed information regarding the user that invoked the installer, host name, 
operating system details, and so on    

 l List of installed assemblies   

 l Information related to the Ant scripts run by the installer    

To change the location of the installer log file, specify the    -V logFile="myLogFile" option 
when you run the installer.    
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact TIBCO 
Support, and join TIBCO Community.

How to Access TIBCO Documentation

 Documentation for TIBCO products is available on the Product Documentation website, 
mainly in HTML and PDF formats.    

 The Product Documentation website is updated frequently and is more current than any 
other documentation included with the product.

Product-Specific Documentation

The documentation for this product is available on the TIBCO ActiveMatrix BusinessWorks™ 
Plug-in for Change Data Capture Documentation page.

How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:    

 l To access the Support Knowledge Base and getting personalized content about 
products you are interested in, visit our product Support website.     

 l To create a Support case, you must have a valid maintenance or support contract 
with a Cloud Software Group entity. You also need a username and password to log 
in to the product Support website. If you do not have a username, you can request 
one by clicking Register on the website.      

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee 
subject matter experts to share and access their collective experience. TIBCO Community 
offers access to Q&A forums, product wikis, and best practices. It also offers access to 
extensions, adapters, solution accelerators, and tools that extend and enable customers to 
gain full value from TIBCO products. In addition, users can submit and vote on feature 

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-activematrix-businessworks-plug-in-for-change-data-capture
https://docs.tibco.com/products/tibco-activematrix-businessworks-plug-in-for-change-data-capture
https://support.tibco.com/
https://support.tibco.com/
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requests from within the      TIBCO Ideas Portal. For a free registration, go to      
TIBCO Community. 

https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED, 
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE 
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE 
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG 
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED  SOFTWARE IS NOT LICENSED TO BE USED OR 
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER 
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS 
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO 
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN 
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS 
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP 
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE 
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF 
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this 
document may be reproduced in any form without the written authorization of Cloud Software 
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, Business Studio, and TIBCO 
Business Studio  are either registered trademarks or trademarks of Cloud Software Group, Inc. in the 
United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of 
their respective owners and are mentioned for identification purposes only. You acknowledge that all 
rights to these third party marks are the exclusive property of their respective owners. Please refer to 
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is 
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

Cloud SG software may be available on multiple operating systems. However, not all operating 
system platforms for a specific software version are released at the same time. See the “readme” file 
for the availability of a specific version of Cloud SG software on a specific operating system platform.

https://www.cloud.com/legal
https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES 
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED 
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN 
THE PRODUCT(S), THE PROGRAM(S),  AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY 
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR 
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT 
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer 
to the Virtual Patent Marking document located at https://www.cloud.com/legal.

Copyright © 2023-2025. Cloud Software Group, Inc. All Rights Reserved.

https://www.cloud.com/legal
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